|
CALIBRATION PROCEDURE

NI PXI-665x

This document describes how to write a calibration procedure for the
10 MHz oscillator frequency of the NI PXI-6653 and NI PXI-6652 timing
and synchronization modules.
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Conventions

The following conventions apply to this document:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

é When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.
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bold

italic

monospace

Software

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

This calibration procedure requires NI-Sync and NI-VISA. NI-Sync and
NI-VISA support a number of application development environments
(ADESs) and programming languages, including LabVIEW,
LabWindows™/CVI™, and Microsoft Visual C++. When you install the
drivers, you need to install support for only the ADE or programming
language you are using. The illustrations in this document show the
LabVIEW code for implementing calibration steps using NI-Sync and
NI-VISA.

Documentation

You need the NI-Sync User Manual to calibrate the NI PXI-665x.

The NI-Sync User Manual contains detailed information about using

the NI-Sync driver, including information about installing NI-Sync and
creating applications that use the NI-Sync driver. These sources, along with
this document, are your primary references for writing your calibration
utility. You also can refer to the documentation for the programming
language or application development environment you are using. For
further information about the device you are calibrating, refer to the

NI PXI-665x User Manual.
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Calibration Interval

Password

The measurement requirements of the application determine how often you
should calibrate the device to ensure its accuracy. National Instruments
recommends that you calibrate the NI PXI-6653 and NI PXI-6652 yearly.
You may want to shorten this interval based on the application demands.

The default password for password-protected operations is NT.

Test Equipment

Calibrating the NI PXI-665x requires the following equipment.

Equipment

Recommended Model

Requirements

10 MHz clock source

Symmetricom/Datum 8040

Accurate to within

0.75 parts-per-billion (ppb) for the
NI PXI-6653, or 150 ppb for the
NI PXI-6652.

BNC-SMB cable

SMB-SMB cable

Test Conditions

Follow these guidelines to optimize connections and test conditions during

the calibration procedure:

* Install the NI PXI-665x in Slot 2 of the PXI chassis. The calibration
procedure requires features of PXI that are accessible only in slot 2.

*  Maintain a temperature of approximately 25 °C.

*  Keep relative humidity below 80 percent.

»  Use shielded copper wire for all cable connections to the device.

* Allow a warm up time of at least 15 minutes for the NI PXI-6652 and
three hours for the NI PXI-6653 to ensure the measurement circuitry is
at a stable operating temperature.

*  Keep PXI chassis filters clean and fan speed set to High.
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Calibration Procedure

The steps used in the calibration procedure are as follows:
1. Initial setup.
2. Verification.
3. Adjustment.
4

Reverification.

Initial Setup
Complete the following steps to set up the NI PXI-665x for calibration.

1. Make sure all components involved in the calibration procedure are
powered off.

2. Install the NI PXI-665x board into slot 2 of your chassis.
@ Note The module must be installed in slot 2 of the chassis.

Power on the PXI chassis first, and then the external equipment.

4. Make sure that all the appropriate driver and application software is
installed on the host computer.

5. Configure the hardware properly with Measurement & Automation
Explorer (MAX). Refer to the NI PXI-665x Installation Guide for
details about configuring the PXI equipment.

Verification

The following steps outline the procedure for measuring the 10 MHz
oscillator frequency on the NI PXI-665x and determining whether the
device requires adjustment to meet the published specifications.

Connecting the Clock Source

1. Connect the accurate 10 MHz source to the ClkIn connector on the
NI PXI-665x.

2. Program the NI PXI-665x to route the ClkIn signal to PXI_Clk10In
without using its 10 MHz PLL by completing steps a—d.

@ Note Use the data in the C function call reference as inputs to your LabVIEW VI where
applicable.
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a.

Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram

NI-SYNC C Function Call

resource hame [

Labeky

inztrument handle oot

S mar out

beelp]

Call niSync_init with the following
parameters:

resourceName: Devl
idQuery: NULL
resetDevice: VI_TRUE
vi: *SessionHandle

b. Set a writable NI-Sync property node to pass FALSE to the
Use PLL? attribute.
LabVIEW Block Diagram NI-SYNC C Function Call

referance in reference oul
Property Mode I

errar in Bz iSync B

[===H P Use PLL?

Clk. Properties:Use PLL? |

Call niSync_SetAttributevViBoolean
with the following parameters:

vi: “<SessionHandle> "
terminalName: *

attributelD:
NISYNC_ATTR_CLKIN_USE_PLL
attributeValue: VI_FALSE

c. Call niSync Connect Clock Terminals VI to connect ClkIn to
PXI_CIk10_In.
LabVIEW Block Diagram NI-SYNC C Function Call

instrument handle in

zource terminal
Clkin =

destination kerminal

hiGync Conmect Clock T erminals. vl

itstrument handle out

eror in [no error
[E=ck beceveed Fra s |

Call niSync_ConnectClkTerminals
with the following parameters:

vi: “<SessionHandle> "
sourceTerminal: NTSYNC_VAL_CLKIN
destinationTerminal:
NISYNC_VAL_CLK10

© National Instruments Corporation
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d. Call niSync Close VI to close the handle.

LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_close with the following
parameter:

instrument handle in|

vi: *<SessionHandle> "

I, i
errar in [na erar B p5 |
Measuring the Frequency
Complete the following procedure to measure the frequency of the onboard
clock source.
1. Connect the ClkOut terminal to the PFI O terminal by using an
SMB-to-SMB cable.
2. Complete steps a—d to program the board to connect the onboard
oscillator to ClkOut. Be sure to use the high-gain setting for clock out.
a. Call niSync Initialize VI to set up a handle for the device.
LabVIEW Block Diagram NI-SYNC C Function Call
Call nisync_init with the following
resourcs hame [ instrument handle out parameters:
BT

resourceName: Devl
idQuery: NULL (ignored)

-, resetDevice: VI_FALSE
vi: *SessionHandle

b. Setawritable NI-Sync property node to pass TRUE to the ClIkOut
Gain Enable attribute.

LabVIEW Block Diagram NI-SYNC C Function Call

Call nisync_SetAttributeViBoolean

T ——) with the following parameters:
) ,
J— vi: “<SessionHandle> "
Property Mods . R

o ] T o © tern-llnalName.
[Sack e DUt G210 E nable attributelD:

NI S"YNC_ATTR_CLKOUT_GAIN_ENABLE
[ —— = attributeValue: VI_TRUE

Clk Properties: ClkOut Gain Enable]
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c. Call niSync Connect Clock Terminals VI to connect the oscillator

to ClkOut.
LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_ConnectClkTerminals
instument handie inl  [Syno Connect Clock Temminals v with the following parameters:

inztrument handle out vi: “<SessionHandle>"
sourceTerminal:
NISYNC_VAL_OSCILLATOR
destinationTerminal:
NISYNC_VAL_CLKOUT

zource terminal

Oscillator ~

destingtion berminal

&Iror in (o error ermor out

=it S|

d. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_close with the following
parameter:

instrument handle in

rigync Cloge. vi

HI-ZYH

vi: “<SessionHandle> "

[ —

error in [ho erraor ooy b5

3. Complete steps a—c to measure the oscillator frequency through PFI 0.
To obtain an accurate measurement for calibration, the measurement
duration must be made sufficiently long. Refer to Table 1 for the
measurement duration to use.

Table 1. Measurement Duration

Required Measurement
Device Measure Accuracy Duration
NI PXI-6652 200 ppb 0.5 seconds
NI PXI-6653 1 ppb 100 seconds
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a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call
Call nisync_init with the following
resource name [ instrurnent handle out

- error oul]
rezet device

- |

parameters:
resourceName: Devl

idQuery: NULL
resetDevice: VI_FALSE

vi: *SessionHandle

b. Call niSync Measure Frequency VI to measure the frequency of

the oscillator.

LabVIEW Block Diagram

NI-SYNC C Function Call

riSync Measure Frequency. vi
HI=Z7HC

instrument handle out

170
itstrument handle

measured frequenc
>
0h
Errar in| [errer oul]
[ e I » E

Call niSync_MeasureFrequency with
the following parameters:

vi: *<SessionHandle> "
sourceTerminal:
NISYNC_VAL_OSCILLATOR
duration: 0.5 or 100
actualDuration: *actualDuration
measuredFrequency:
*measuredFrequency

error: *error

c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle in|

niSync Cloge.vi

: i lemrar oul
ermon in [ho error bl p5at ]

Call nisync_close with the following
parameter:

vi: “<SessionHandle>”

NI PXI-665x Calibration Procedure

4. Compare the measured frequency to the device specifications.

To determine if the device under test meets its specifications, you must
compare the measured frequency obtained in Step 3 of Measuring the
Frequency with the specified accuracy. Table 2 shows the frequency range
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that is acceptable according to the published specifications for the

NI PXI-665x.

Table 2. Acceptable Frequency Ranges

. Acceptable Frequency Range
Specified
Device Accuracy Low Limit High Limit
NI PXI-6652 +2.5 ppm 9,999,975 Hz 10,000,025 Hz
(TCXO)
NI PXI-6653 +3.2 ppb 9,999,999.968 Hz 10,000,000.032 Hz
(0CX0)
If the measured value is within the low-limit and high-limit range listed
under the Acceptable Frequency Range, the board is calibrated correctly.
Adjustment
If the accuracy of the 10 MHz oscillator is outside the specified range
for the product, the device is out of calibration. A programmable voltage
controls the oscillator frequency. By varying this voltage and precisely
measuring the frequency, you can find a voltage that gives a frequency as
close as possible to 10 MHz.
1. Complete steps a—c to set the oscillator control voltage. The range of
acceptable voltage values is 0.0 V to 4.095 V with frequency
increasing as voltage increases. Use a control voltage of 2.0475 V,
which is in the middle of the valid range, as a starting point.
a. Call niSync Initialize VI to set up a handle for the device.
LabVIEW Block Diagram NI-SYNC C Function Call
Call niSync_init with the following
esourcs hame [*] instrument handle out parameters:
[2b<h

resel device

; error aut
becey b T

idQuery: NULL

resourceName: Devl

resetDevice: VI_FALSE
vi: ¥*SessionHandle

© National Instruments Corporation

NI PXI-665x Calibration Procedure



b. Set a writable NI-Sync property node to pass the constant 2.0475
to the Oscillator Voltage attribute.

LabVIEW Block Diagram

NI-SYNC C Function Call

reference in|

reference oul

Property Mode _J—

Ely g-c niSync g
[EaiH ¥
2.0475 b=zl

[Calibration Properties: Ozcillatar Valtage]

Call nisync_SetAttributeViBoolean
with the following parameters:

vi: “<SessionHandle> "~

terminalName: “

attributelD:
NISYNC_ATTR_OSCILLATOR_VOLTAGE
attributeValue: 2.0475

c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrument handle iny

niSvne Cloze. vi

HI-;

[T et :
Ermar in o 2rrar h.=-'=:

Call nisync_close with the following
parameter:

vi: “<SessionHandle> "

NI PXI-665x Calibration Procedure

Proceed with the following steps to find the correct oscillator control

voltage.

2. After setting the control voltage, measure the frequency again with
the NI-Sync Measure Frequency VI to measure PFI 0, as shown in
Step 3 of the Measuring the Frequency section. To obtain an accurate
measurement for calibration, the measurement duration must be made
sufficiently long. Refer to Table 1, Measurement Duration, for the
measurement duration to use.
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Complete steps a—c to measure PFI 0.

a. Call niSync Initialize VI to set up a handle for the device.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_init with the following
parameters:

resource name [ instrurnent handle oul

resourceName: Devl

: idQuery: NULL

= resetDevice: VI_FALSE
vi: *SessionHandle

reset device

b. Call niSync Measure Frequency VI to measure the frequency of
the oscillator.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_MeasureFrequency with
the following parameters:

nisS

HI-Z¥I

nc Measure Fraquency. vi

itstrument handle oot

— 1 | vi: “<SessionHandle>”
instrument handley sourceTerminal:
NISYNC_VAL_OSCILLATOR
duration duration: 0.5 or 100
05 actualDuration: *actualDuration
i measuredFrequency:
@ m *measuredFrequency

error: *error

c. Call niSync Close VI to close the session handle.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_close with the following

instrurment handle in parameter:

. .
S e vi: “<SessionHandle> "~

e | Frorod
error in [ho erraor ooy b5

Compare the measured frequency to the device specifications.

4. If the measured frequency is still outside of the specified limit, repeat
steps 1-3 of the Adjustment section until the measured value falls
within the acceptable frequency range for your module, as shown in
Table 2, Acceptable Frequency Ranges.
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5. Commit the calibration values to the Calibration EEPROM using
the following procedure.

a. Call niSync Initialize External Calibration VI to initialize the

process.

Note N1 is the default user password. If you have changed the calibration password, use

your user-selected calibration password in place of NI.

LabVIEW Block Diagram

NI-SYNC C Function Call

nis

ne Initialize External Calibration. vl

- SYHE
L

:
e =1

instrument handle oul

Call niSync_InitExtCal with the
following parameters:

resourceName: “<MAX ID>"
password: NI
calibrationInstrumentHandle:
*SessionHandle

b. Call niSync Adjust Oscillator Voltage VI to adjust the voltage of
the oscillator.

LabVIEW Block Diagram

NI-SYNC C Function Call

instrurment handle in

ni%ync Adiust Oscilatar Yaoltage. vl

20475

instrument handle oul

Call
niSync_CalAdjustOscillatorVoltage
with the following parameters:

vi: “<SessionHandle> "~

new Voltage: <new control voltage>
oldVoltage: *oldvoltage

NI PXI-665x Calibration Procedure
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c. Call niSync Close External Calibration VI to commit the settings
and close the session.

LabVIEW Block Diagram NI-SYNC C Function Call

Call niSync_CloseExtCal with the

instument handle inf (15 nc Close Extemal Calibration. i) following parameter:
Hl-THG

vi: “<SessionHandle> "
action: NISYNC_VAL_EXT CAL_COMMIT

Reverification

After completing the adjustments to the NI PXI-665x, it is important that
you verify the oscillator frequency operation by repeating the steps listed
in the Verification section. Re-verifying after making the adjustments
ensures that the NI PXI-665x is operating within its test limits.
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Where to Go for Support

The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni . com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:

Australia 1800 300 800, Austria 43 662 457990-0,

Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599,

Canada 800 433 3488, China 86 21 5050 9800,

Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,

Finland 385 (0) 9 725 72511, France 01 57 66 24 24,

Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737,
Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710,

Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,

New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60,

Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 495 783 6851,
Singapore 1800 226 5886, Slovenia 386 3 425 42 00,

South Africa 27 0 11 805 8197, Spain 34 91 640 0085,

Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151,

Taiwan 886 02 2377 2222, Thailand 662 278 6777,

Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.
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